
Basic 3D Flash Programming with Papervision3D
The following sample codes are only used to demonstrate the very basics  of 3D Flash Programming with 
Papervision3D, which are:

1. Setting up the Environment  

2. Initializing Papervision3D  

3. Loading and Displaying external 3D model  

4. Interacting with 3D  

Before  you  continue  reading,  please  bear  in  mind  that  aside  from  Papervision3D,  the  codes  below  use 
MovieClip3D class  which  is  from  another  framework,  called  WIND,  thus  it  is  not  included  to 
Papervision3D's official distribution.

To know more about WIND, see http://konsolscript.org/~mjmendoza/wind/.

Setting up the Environment
1. Open FlashDevelop if you haven't done it yet.

2. Create a new project by clicking Project > New Project. A dialog box will pop-up.

3. Select AS3 Project template, then type the name of your project. Toggle-on, Create directory for 
project.

4. Add the frameworks, Papervision3D and Wind, to classpath either from:

◦ Project > Properties > Classpaths > Add Classpath... or

◦ Tools > Global Classpaths > Add Classpath...

Initializing Papervision3D
Open Main.as and change its content to the code written below.  Compile and Run the program by pressing 
Ctrl + Enter. It will be just plain white as there's nothing to display. Even so, Papervision3D is now initialized.

package {
  import flash.display.Sprite;
  import flash.events.Event;

  import org.papervision3d.cameras.CameraType;
  import org.papervision3d.view.BasicView;
  import org.papervision3d.lights.PointLight3D;
  /**
   * ...
   * @author {Your Name}
   */
  public class Main extends Sprite {
    private var view:BasicView;
    public function Main():void {
      if (stage) init();
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      else addEventListener(Event.ADDED_TO_STAGE, init);
    }
    
    private function init(e:Event = null):void {
      removeEventListener(Event.ADDED_TO_STAGE, init);
      // entry point

      view = new BasicView(600, 400, false, true, CameraType.FREE);
        addChild(view);
      
      addEventListener(Event.ENTER_FRAME, onRenderViewport);
    }

    private function onRenderViewport(e:Event):void {
      view.singleRender();
    }
  }
}

Loading and Displaying external 3D model
Add the codes highlighted below and compile the program. Provided that “test1.dae” exists, you should be 
able to see the exported model in your 3D flash program.

package {
  import flash.display.Sprite;
  import flash.events.Event;
  
  import org.papervision3d.cameras.CameraType;
  import org.papervision3d.view.BasicView;
  import org.papervision3d.lights.PointLight3D;
  
    import org.papervision3d.objects.parsers.DAE;
    import org.wind.display.MovieClip3D;
    import org.wind.display.Sprite3D;
  
  /**
   * ...
   * @author {Your Name}
   */
  public class Main extends Sprite {
    private var view:BasicView;
    private var mc3D:MovieClip3D;
    
    public function Main():void {
      if (stage) init();
      else addEventListener(Event.ADDED_TO_STAGE, init);
    }
    
    private function init(e:Event = null):void {
      removeEventListener(Event.ADDED_TO_STAGE, init);
      // entry point
      
      view = new BasicView(600, 400, false, true, CameraType.FREE);
        addChild(view);
      
      mc3D = new MovieClip3D();
        view.scene.addChild(mc3D);
        
      var dae:DAE = new DAE();
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        dae.load("test1.dae");
          mc3D.addFrame(new Sprite3D(dae));
      
        mc3D.scale = 50; //change to desired value
        mc3D.play(true,true);
      addEventListener(Event.ENTER_FRAME, onRenderViewport);
    }
    
    private function onRenderViewport(e:Event):void {
      mc3D.render();
      mc3D.rotationY++;
      view.singleRender();
    }
  }
}

Displaying an Animated 3D model

2-framed Animation
To have an animating 3D object, you can use MovieClip3D's addFrame to load two or more pre-animated 
exported models. The code below will show you how to do it.

package {
  import flash.display.Sprite;
  import flash.events.Event;
  
  import org.papervision3d.cameras.CameraType;
  import org.papervision3d.view.BasicView;
  import org.papervision3d.lights.PointLight3D;
  
    import org.papervision3d.objects.parsers.DAE;
    import org.wind.display.MovieClip3D;
    import org.wind.display.Sprite3D;
  
  /**
   * ...
   * @author {Your Name}
   */
  public class Main extends Sprite {
    private var view:BasicView;
    private var mc3D:MovieClip3D;
    
    public function Main():void {
      if (stage) init();
      else addEventListener(Event.ADDED_TO_STAGE, init);
    }
    
    private function init(e:Event = null):void {
      removeEventListener(Event.ADDED_TO_STAGE, init);
      // entry point
      
      view = new BasicView(600, 400, false, true, CameraType.FREE);
        addChild(view);
      
      mc3D = new MovieClip3D();
        view.scene.addChild(mc3D);
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      var dae:DAE = new DAE();
        dae.load("test1.dae");
          mc3D.addFrame(new Sprite3D(dae), 10); // change 10 to desired value
      var dae2:DAE = new DAE();
        dae2.load("test2.dae");
          mc3D.addFrame(new Sprite3D(dae2), 10); // change 10 to desired value
      
        mc3D.scale = 50; //change to desired value
        mc3D.play(true,true);

      addEventListener(Event.ENTER_FRAME, onRenderViewport);
    }
    
    private function onRenderViewport(e:Event):void {
      mc3D.render();
      mc3D.rotationY++;
      view.singleRender();
    }
  }
}

Sequenced Animation
Provided that you have exported a sequence of animated model with names, “test1.dae”, “test2.dae”, 
…,  “testN.dae”, you can use MovieClip3D's addColladaSequence to animated them in flash.

package {
  import flash.display.Sprite;
  import flash.events.Event;
  
  import org.papervision3d.cameras.CameraType;
  import org.papervision3d.view.BasicView;
  import org.papervision3d.lights.PointLight3D;
  
    import org.papervision3d.objects.parsers.DAE;
    import org.wind.display.MovieClip3D;
    import org.wind.display.Sprite3D;
  
  /**
   * ...
   * @author {Your Name}
   */
  public class Main extends Sprite {
    private var view:BasicView;
    private var mc3D:MovieClip3D;
    
    public function Main():void {
      if (stage) init();
      else addEventListener(Event.ADDED_TO_STAGE, init);
    }
    
    private function init(e:Event = null):void {
      removeEventListener(Event.ADDED_TO_STAGE, init);
      // entry point
      
      view = new BasicView(600, 400, false, true, CameraType.FREE);
        addChild(view);
      
      mc3D = new MovieClip3D();
        view.scene.addChild(mc3D);
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      mc3D.addColladaSequence("test", null, "", 25, 1); // change 25 and 1 to desired 
value
      
        mc3D.scale = 50; //change to desired value
        mc3D.play(true,true);

      addEventListener(Event.ENTER_FRAME, onRenderViewport);
    }
    
    private function onRenderViewport(e:Event):void {
      mc3D.render();
      mc3D.rotationY++;
      view.singleRender();
    }
  }
}

Interacting with 3D

Adding Interaction
It's time to throw in some interaction. Let's add event listeners to keyboard inputs using KeyboardEvent.

package {
  import flash.display.Sprite;
  import flash.events.Event;
  import flash.events.KeyboardEvent;
  import flash.ui.Keyboard;
  
  import org.papervision3d.cameras.CameraType;
  import org.papervision3d.view.BasicView;
  import org.papervision3d.lights.PointLight3D;
  
    import org.papervision3d.objects.parsers.DAE;
    import org.wind.display.MovieClip3D;
    import org.wind.display.Sprite3D;
  
  /**
   * ...
   * @author {Your Name}
   */
  public class Main extends Sprite {
    private var view:BasicView;
    private var mc3D:MovieClip3D;
    
    public function Main():void {
      if (stage) init();
      else addEventListener(Event.ADDED_TO_STAGE, init);
    }
    
    private function init(e:Event = null):void {
      removeEventListener(Event.ADDED_TO_STAGE, init);
      // entry point
      
      view = new BasicView(600, 400, false, true, CameraType.FREE);
        addChild(view);
      
      mc3D = new MovieClip3D();
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        view.scene.addChild(mc3D);
        
      mc3D.addColladaSequence("test", null, "", 25, 1); // change 25 and 1 to desired 
value
      
        mc3D.scale = 50; //change to desired value
        mc3D.play(true,true);

      addEventListener(Event.ENTER_FRAME, onRenderViewport);
      stage.addEventListener(KeyboardEvent.KEY_DOWN, stage_onKeyDown);
      stage.addEventListener(KeyboardEvent.KEY_UP, stage_onKeyUp);
    }
    
    private var rotateLeft:Boolean;
    
    private function stage_onKeyDown(e:KeyboardEvent):void {
      if (e.keyCode == Keyboard.LEFT) {
        rotateLeft = true;
      }
    }
    
    private function stage_onKeyUp(e:KeyboardEvent):void {
      if (e.keyCode == Keyboard.LEFT) {
        rotateLeft = false;
      }
    }
    
    private function onRenderViewport(e:Event):void {
      mc3D.render();
      if (rotateLeft) {
        mc3D.rotationY++;
      }
      
      mc3D.rotationY++;
      view.singleRender();
    }
  }
}

Moving the 3D around
Adding more key listeners, let us move that 3D model around using DisplayObject3D's moveForward 
and moveBackward functions.

package {
  import flash.display.Sprite;
  import flash.events.Event;
  import flash.events.KeyboardEvent;
  import flash.ui.Keyboard;
  
  import org.papervision3d.cameras.CameraType;
  import org.papervision3d.view.BasicView;
  import org.papervision3d.lights.PointLight3D;
  
    import org.papervision3d.objects.parsers.DAE;
    import org.wind.display.MovieClip3D;
    import org.wind.display.Sprite3D;
  
  /**
   * ...
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   * @author {Your Name}
   */
  public class Main extends Sprite {
    private var view:BasicView;
    private var mc3D:MovieClip3D;
    
    public function Main():void {
      if (stage) init();
      else addEventListener(Event.ADDED_TO_STAGE, init);
    }
    
    private function init(e:Event = null):void {
      removeEventListener(Event.ADDED_TO_STAGE, init);
      // entry point
      
      view = new BasicView(600, 400, false, true, CameraType.FREE);
        addChild(view);
      
      mc3D = new MovieClip3D();
        view.scene.addChild(mc3D);
        
      mc3D.addColladaSequence("test", null, "", 25, 1); // change 25 and 1 to desired 
value
      
        mc3D.scale = 50; //change to desired value
        mc3D.play(true,true);

      addEventListener(Event.ENTER_FRAME, onRenderViewport);
      stage.addEventListener(KeyboardEvent.KEY_DOWN, stage_onKeyDown);
      stage.addEventListener(KeyboardEvent.KEY_UP, stage_onKeyUp);
    }
    
    private var rotateLeft:Boolean;
    private var rotateRight:Boolean;
    private var moveForward:Boolean;
    private var moveBackward:Boolean;
    
    private function stage_onKeyDown(e:KeyboardEvent):void {
      if (e.keyCode == Keyboard.LEFT) {
        rotateLeft = true;
      } else if (e.keyCode == Keyboard.RIGHT) {
        rotateRight = true;
      } else if (e.keyCode == Keyboard.UP) {
        moveForward = true;
      } else if (e.keyCode == Keyboard.DOWN) {
        moveBackward = true;
      }
    }
    
    private function stage_onKeyUp(e:KeyboardEvent):void {
      if (e.keyCode == Keyboard.LEFT) {
        rotateLeft = false;
      } else if (e.keyCode == Keyboard.RIGHT) {
        rotateRight = false;
      } else if (e.keyCode == Keyboard.UP) {
        moveForward = false;
      } else if (e.keyCode == Keyboard.DOWN) {
        moveBackward = false;
      }
    }
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    private function onRenderViewport(e:Event):void {
      mc3D.render();
      if (rotateLeft) {
        mc3D.rotationY++;
      } else if (rotateRight) {
        mc3D.rotationY--;
      }
      
      if (moveForward) {
        mc3D.moveForward(3);
      } else if (moveBackward) {
        mc3D.moveBackward(3);
      }
      mc3D.rotationY++;
      view.singleRender();
    }
  }
}

Where to go from here?
With these  basics,  you can  now make flash-based websites  in  3D.  Make 3D games.  The  possibilities  are 
endless. You are only limited by your imagination and creativity.

You can delve deeper to Augmented Reality.

Learn more of Papervision3D. Join the community at http://forum.papervision.org.

Resources
You can get a PDF copy of this article and source code from the site indicated below.

http://konsolscript.org/~mjmendoza/papervision/

Related Article
Interested in Game Programming? Check out:

http://konsolscript.org/~mjmendoza/freebasic/basic-game-programming-with-freebasic/
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